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Concept of Weighted Averages (Background Information) 
Performance in a course is evaluated by assigning weights that reflect the importance of 
each aspect of the course towards the overall course goals. These weights are used in 
computing overall course grades. For example, a syllabus might specify the following 
weights for different categories of performance:  

• Final Exam 20% 
• Major Exams 40% 
• Quizzes 10% 
• Homework 10% 
• Lab 20% 
• Total 100% 

 
Suppose your averages in each category are: Final Exam = 80%, Major Exams = 70%, 
Quizzes = 50%, Homework = 100%, Lab = 95%. Your final grade would be computed by 
multiplying each average times the associated weight, and summing the results. 
 

Category Weight Grade Weighted Score  
Final Exam 20% 80 16.0 

Major Exams 40% 70 28.0 
Quizzes 10% 50 5.0 

Homework 10% 100 10.0 
Lab 20% 95 19.0 

  Total 78.0 
 

It is possible to weight scores within each category, such as homework. This makes 
sense. Some homework assignments are more difficult or more important than others. 
Suppose you have 3 homework assignments. Together, these make up 10% of your 
overall grade. Suppose Homework #1 is worth 2%, Homework #2 is worth 5%, and 
Homework #3 is worth 3%. The table can be generalized to accommodate these 
individual assignment weights. Suppose your homework scores are HW #1 = 50%, HW 
#2 = 100%, HW #3 = 90%. Other scores are as recorded earlier. Here are the results. 
 

Category 
Category 
Weight Item 

Item 
Weight Grade 

Weighted 
Score 

Final Exam 20%  20% 80 16.0 
Major Exams  40%  40% 70 28.0 
Quizzes 10%  10% 50 5.0 
Homework 10% HW #1 2% 50 1.0 
  HW #2 5% 100 5.0 
  HW #3 3% 90 2.7 
Lab 20%  20% 95 19.0 
    Total 76.7 
The lab that follows will give you the experience in setting up a grade sheet. You can use 
this for all your classes. Start a new spreadsheet for each class. 
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Introduction to Lab Procedure 
This is a simple first exercise in using Excel. You will use formulas on a spreadsheet to 
compute grades. You will add headers and format labels. You will print the spreadsheet 
and the formula sheet. 

Cell Reference Notation: (Information) Cells in a Microsoft Excel Spreadsheet are 
referenced in one of two ways.  One way is by a column letter and a row number.  For 
example, cell D5 is the cell located at the intersection of column D and row 5.  Relative 
cell references will change if you drag the formula to a new cell.  A relative cell 
reference does not have a dollar sign in front of it, such as D5. An absolute cell reference 
will not change if you drag the formula to a new cell.  An absolute cell reference has a 
dollar sign using forms such as D$5, $D5, and $D$5.  In the example of D$5, the 
reference to column D is a relative reference, and the reference to row 5 is an absolute 
reference. A cell reference in a macro uses row and column numbers, such as cells(5,4), 
which refer to the cells(row,column). 

Notation (Information) 
The vertical bar notation “File | Save As” or “File | Properties” is used to indicate a 
sequence of commands or menu choices. For example, “Format | Cells… | Number | 
Number | Decimal places = 2” means 

• Click on the “Format” menu 
• Select the “Cells…” submenu 
• Select the “Number” tab 
• Select the “Number” entry from the selection list 
• Set “Decimal places” equal to “2” 

Before Starting Excel (Information) 
To do this lab, you must have access to your H drive. Be sure that you log on to your 
account under both NT-4 and UNIX. 

Initialize File (Procedure) 
1. Start Microsoft Excel. 
2. Select Cell A1. Enter your name. 
3. Save the empty file to set up preserving your work periodically. 

File | Save As 
In the “Save in:” list box, select the directory to save your work on the H 
drive:  H:\CSC100\Excel. 

In the “File name:” edit box, enter the name “Excel Weighted Grade Evaluation”. 
Click the “Save” button in the “Save As” dialog box. 

4. Enter documentation into the Properties Sheet. File | Properties 
Title: Excel Weighted Grade Evaluation 
Subject: Weighted grade computation 
Author: Enter your name. 
Company: Enter your military unit, business, church, organization, or school 

name. 
Comments: Use formulas to compute course grade. 
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Click the “OK” button in the Properties dialog box. 
5. Click the SAVE icon. This is the 3rd icon on the Standard Toolbar. It looks like a 

floppy disk.  
Throughout this assignment, you should click the SAVE icon about every 5 minutes, and 

after finishing each major section of this assignment. 

Sample Spreadsheet (Information) 
 
Your Name      

Category 
Category
Weight Item 

Item 
WeightGrade 

Weighted
Score 

Final Exam 20% Final Exam 20.0% 70.0 14.00

Major Exams 40% Exam #1 10.0% 60.0 6.00

  Exam #2 10.0% 70.0 7.00

  Exam #3 10.0% 80.0 8.00

  Exam #4 10.0% 75.0 7.50

Quizzes 10% Quiz #1 2.0% 70.0 1.40

  Quiz #2 2.0% 80.0 1.60

  Quiz #3 2.0% 75.0 1.50

  Quiz #4 2.0% 85.0 1.70

  Quiz #5 2.0% 91.0 1.82

Homework 10% HW #1 0.5% 50.0 0.25

  HW #2 0.5% 75.0 0.38

  HW #3 1.0% 100.0 1.00

  HW #4 1.0% 100.0 1.00

  HW #5 1.0% 80.0 0.80

  HW #6 1.0% 50.0 0.50

  HW #7 1.0% 0.0 0.00

  HW #8 0.5% 80.0 0.40

  HW #9 0.5% 50.0 0.25

  HW #10 0.5% 100.0 0.50

  HW #11 0.5% 75.0 0.38

  HW #12 0.5% 80.0 0.40

  HW #13 0.5% 80.0 0.40

  HW #14 0.5% 100.0 0.50

  HW #15 0.5% 50.0 0.25

Lab 20% Lab #1 2.0% 25.0 0.50

  Lab #2 2.0% 50.0 1.00

  Lab #3 2.0% 80.0 1.60

  Lab #4 2.0% 95.0 1.90

  Lab #5 2.0% 80.0 1.60

  Lab #6 2.0% 80.0 1.60

  Lab #7 2.0% 95.0 1.90

  Lab #8 2.0% 50.0 1.00

  Lab #9 2.0% 75.0 1.50

  Lab #10 2.0% 80.0 1.60

    Total: 71.72



Microsoft Excel Lab CSC100   
Weighted Grade Evaluation Methodist College  5 March 2004 

5

When you finish your project, it should look like the sample above. Do not type in all 
the numbers. Follow the procedure. Use of copy features and formulas greatly reduces 
the time and effort needed. 

Sample Syllabus Grading Plan (Information) 
For the purpose of this lab, assume your course syllabus specifies the following plan for 
weighting grades. Unless otherwise specified, assume that within each category that 
equal weight is given for each assignment. 

Final Exam: Category Weight: 20%. 
Exams #1 – 4: Category Weight: 40%. 
Quizzes #1 – 5: Category Weight: 10%. 
Homework: #1 – 15: Category Weight: 10%. Item Weights: HW #3 – 7: 1% each. All 

others: 0.5%. 
Labs #1 - 10: Category Weight: 20%. 

Create Structure of Spreadsheet (Procedure) 
Enter Column Heading Labels 
Enter labels into cells as given in the sample spreadsheet. 
To create a new line within a cell, use Alt + Enter. 

6. Enter column headings in row 2, beginning in column A. 

Category 
Category 
Weight Item 

Item 
Weight Grade 

Weighted 
Score 

Enter Major Category Row Headings 
7. Enter major category headings into column A with corresponding weights in 

column B. 
Final Exam 20%

Major Exams 40%

Quizzes 10%

Homework 10%

Lab 20%

Insert Rows for Individual Assignments 
Rows are selected by clicking on the gray row numbers in the left column of the 
spreadsheet. 

To insert a new row: 

• Immediately below where you want the new rows, select (highlight) the number 
of rows you want to insert.  

o For example, to insert 3 rows below Row #4 (Major Exams), select 3 rows 
below Row #4. There are rows numbered 5, 6, and 7. 

• Insert the new rows by: Insert | Rows.  

o Continuing the example from the previous step, three new blank rows will 
appear below Row #4. 

Insert blank rows between categories to accommodate each individual assignment. The 
first row in each category is also used as a row for an individual assignment. The number 
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of new rows needed in a category is one fewer than the total number of assignments in 
that category. For example, there are 15 homework assignments, so 14 new rows need to 
be inserted in the homework category. 

8. Insert 3 new rows under Major Exams 
9. Insert 4 new rows under Quizes. 
10. Insert 14 new rows under Homework. 

Notice that all the remaining spreadsheet rows below Labs are blank. We therefore do not 
need to insert more blank rows to accommodate the labs. 
Enter Labels for Individual Assignments 
Enter a Sequence of Labels 
To enter labels with a number at the end that increases: 

11. Enter the first label, such as Exam #1 in column C, row 4. Press Enter. Notice 
that after pressing Enter, a new cell is selected. You will need to reselect the cell 
you just finished working on. 

12. Select the cell with the label you just entered. 
13. Place the mouse cursor on top of the small black square box in the lower right 

corner of the selected cell. The mouse cursor will change shape to a bold plus-

sign.  
14. Use the left mouse button and drag the corner of the box down. A note tag will 

appear  after you start dragging to display the value to be 

entered into the new cell when you release the mouse button.  
Enter Remaining Assignments 

15. Using the procedure above, enter labels for  
a. Quiz #1 through Quiz #5 
b. Homework #1 through Homework #15 
c. Lab #1 through Lab #10 

Format the Assignment Labels 
16. Select and bold the row and column labels. 

To make a selected cell bold, click on the Bold button  on the formatting 
toolbar. 

Name the Spreadsheet 
17. Name the spreadsheet by entering its name on the tab at the bottom of the 

spreadsheet, using the following procedure: 
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a. Double-click on the tab at the bottom of the spreadsheet. The label will be 

highlighted.   
b. Enter the label “Grades”. 

c. Press “Enter”.  

Specify the Number Format for Columns 
To select a whole column, click on the column label in the gray area at the top of the 

column.  
18. Format Column B to be Percentage with 0 decimal places. In abbreviated 

notation, the procedure is: 
Format | Cells… | Number | Category | Percentage | Decimal places = 0. 

a. Select column B. 
b. On the Format menu, select: Format | Cells.  In the “Format Cells” dialog 

box, on the “Number” sheet, in “Category”, select “Percentage”. 
c. In the “Decimal places” edit box, use the down arrow to select zero if it is 

not already zero. 
d. Click the “OK” button on the Format Cells dialog box.  

 
19. Format Column D to Percentage with 1 decimal place. This is:  

Format | Cells… | Number | Category | Percentage | Decimal places = 1. 
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a. Select column D.  
b. On the Format menu, select: Format | Cells.   
c. In the “Format Cells” dialog box, on the “Number” sheet, in “Category”, 

select “Percentage”.  
d. In the “Decimal places” edit box, use the down arrow to select 1 if it is not 

already 1.  
e. Click the “OK” button on the Format Cells dialog box.  

20. Format Column E to Number with 1 decimal place. This is: 
Format | Cells | Number | Category | Number | Decimal places = 1. 

a. Select column E.  
b. On the Format menu, select: Format | Cells.   
c. In the “Format Cells” dialog box, on the “Number” sheet, in “Category”, 

select “Number”.  
d. In the “Decimal places” edit box, use the down arrow to select 1 if it is not 

already 1.  
e. Click the “OK” button on the Format Cells dialog box.  

21. Format Column F to Number with 2 decimal places. This is: 
Format | Cells… | Number | Category | Number | Decimal places = 2. 

a. Select column F.  
b. On the Format menu, select: Format | Cells.   
c. In the “Format Cells” dialog box, on the “Number” sheet, in “Category”, 

select “Number”.  
d. In the “Decimal places” edit box, use the down arrow to select 2 if it is not 

already 2.  
e. Click the “OK” button on the Format Cells dialog box.  

Enter Grade Weights 
To enter percents, be sure to use the % sign after the number.  

22. Look at the Category Weight and Item Weight columns in the Sample 
Spreadsheet. 

The Category Weight is entered only once beside the category name.  

The Item Weight is entered next to each item. The idea is that the percentage next 
to the Category Weight is being distributed among the individual items 
within that category. 

23. Enter the following weights in the appropriate columns. 
a. Final Exam: Category Weight: 20%. Item Weight: 20%. 
b. Exams #1 – 4: Category Weight: 40%. Item Weight: 10% each. 
c. Quizzes #1 – 5: Category Weight: 10%. Item Weight: 2% each. 
d. Homework: #1 – 15: Category Weight: 10%. 

1. HW #3 – 7: Item Weights 1% each.  
2. All others: Item Weights 0.5%. 

e. Labs #1 - 10: Category Weight: 20%. Item Weights: 2% each. 
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Formulas for Computing Grades (Information) 
Basic Idea 
Two formulas are needed. One formula is used to compute the weighted grade for a 
particular assignment. The other formula is to compute the sum of all the weighted grades 
to get the cumulative grade. 

The first formula will be copied, not reentered, for each assignment. This is a major 
work-saving benefit of using a spreadsheet program. 

Enter a Formula for Assignment Weighted Score  (Procedure) 
Use the following procedure to enter the formula for multiplying Item Weight times 
Grade  to get Weighted Score . 

24. Select cell F3. 
25. Place your mouse cursor over the equal sign = in the formula bar above the 

spreadsheet. A note tag will appear to identify the equal sign as “Edit formula”.  

26. Click on the equal sign.  
A message box will appear with the label “Formula result =”. It may be hiding column 
labels you want to look at.  

27. Drag the message box out of the way.  
a. Place your mouse cursor on a blank area of the message box.  
b. Using the left mouse button, drag the panel to a new location. 

28. Click cell D3. This inserts a reference to D3 (Item Weight) in the formula edit 
box. 

29. Push the asterisk * button on the numeric key pad. The asterisk is used as the 
symbol for multiplication. 

Num 
Lock 

/ * - 

7 
Home 

8 
↑ 

9 
Pg Up 

4 
← 

5 6 
→ 

+ 

1 
End 

2 
↓ 

3 
Pg Dn 

0 
Ins 

. 
Del 

Enter 

 
30. Click cell E3. This inserts a reference to E3 (Grade) in the formula edit box. 
31. Click “OK” in the formula message box (the message box you moved). Cell F3 

will contain a zero because no grade has yet been entered. 
Copy Formula to Other Assignments 

32. Drag the formula in F3 down to define formulas for all other items. 
a. Select cell F3. 
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b. Place the mouse cursor on top of the small black square box in the lower 
right corner of the selected cell. The mouse cursor will change shape to a 
bold plus-sign. 

c. Use the left mouse button and drag the corner of the box down to cell F37. 
The vertical display on the monitor might not display your starting and 
stopping point. 

d. Drag the formula to cell F27. 
e. Use the vertical scroll bar to scroll down until cells F27 and F37 are both 

visible. 
f. Continue dragging the formula down to cell F37. 

Enter Formula for Sum 
33. Enter the formula for the sum. This sum is your cumulative course score. By the 

end of the course, you want this number to equal 100. 
a. Select cell F38. 
b. On the Standard Toolbar, select the summation button, Σ. 

 The formula SUM(F3:F37) will appear in the formula 

edit box.  
c. Press the Enter key. 

34. Label the total.  
a. Select cell E38.  
b. Click on the Bold button in the formatting toolbar.  
c. Enter the label Total:. 

Entering Grades 
Split the Worksheet 
The total course cumulative score is at the bottom of the spreadsheet. To view the effect 
of new grades on the total score as you enter data, split the worksheet using the following 
procedure. 

35. Scroll to the top of the spreadsheet. 
36. Select cell A24. 

 

37. On the Window menu, select “Split”.   
A split bar will partition the window into an upper and a lower part. 
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Each partition has its own vertical scroll bar.   
38. Use the scroll bar in the lower partition to scroll down until the Total label is 

visible in row 38. 
39. Use the upper partition vertical scroll bar to adjust the spreadsheet while you enter 

data. 
Enter Grades 
The grades below are presented in the order that they might be received over time during 
a course. This part of the exercise will demonstrate the effect of entering new grades on a 
cumulative score. 

40. Enter the following grades in the upper partition. 
a. HW #1: 50; HW #2: 75; Lab #1: 25, Quiz #1: 70. 
b. HW #3: 100; Lab #2: 50; HW #4: 100; Lab #3: 80, Quiz #2: 80. 
c. Exam #1: 60 
d. HW #5: 80; Lab #4: 95; HW #6: 50; Lab #5: 80, Quiz #3: 75. 
e. HW #7: 0; HW #8: 80; Lab #6: 80 
f. Exam #2: 70 
g. HW #9: 50; Lab #7: 95; HW #10: 100; Lab #8: 50, Quiz #4: 85. 
h. HW #11: 75; HW #12: 80; Lab #9: 75 
i. Exam #3: 80 
j. HW #13: 80; Lab #10: 80; HW #14: 100; Quiz #5: 91. 
k. HW #15: 50 
l. Exam #4: 75 
m. Final Exam: 70 

If you got all the formulas right, the total should be 71.72 

Page Setup and Print Spreadsheet 
Format the spreadsheet, including headers and footers, to identify the content, the owner, 

and when it was prepared. 
41. On the File menu, select Page Setup. 

Select Page Orientation 
42. In the Page Setup dialog box, On the “Page” tab, under “Orientation”, select 

“Portrait”. (Usually, “Landscape” is a better choice for printing wide tables. This 
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table for this assignment is narrow, so Portrait is satisfactory.) 

 
Select Page Formatting for Spreadsheet Content 

43. On the “Sheet” tab, in the “Print titles” section, and the “Rows to repeat at top:” 
edit box, enter 1:2. This will cause rows #1 and 2 labels to print on additional 
sheets of output if more than one page is needed. 

 
44. On the “Sheet” tab, in the “Print titles” section, and the “Columns to repeat at 

left:” edit box, enter A:A. This will cause column “A” labels to print on additional 
sheets of output if more than one page is needed. Be sure to use the colon between 
the two letters. 

45. On the “Sheet” tab, in the “Print” section, checkmark the “Gridlines” box. This 
will cause light lines to appear on the printed spreadsheet. This is helpful in 
guiding the eyes when reading a table of numbers.  

Setup Header and Footer 
Header 

46. On the “Header/Footer” tab, select “Custom Header…”.  
47. In the “Header” dialog box, click in the “Left section:” edit box. Type your name 

in this box. 
48. In the “Header” dialog box, click in the “Center section:” edit box. Click on the 

“File” icon.  It looks like a blank sheet with the upper right corner bent, and 
with a green X centered on the left edge. This enters the code “&[File]” into the 
edit box. This causes the name of the file to appear centered in the header of the 
output. 

49. In the “Header” dialog box, click in the “Right section:” edit box. Click on the 

“Tab” icon.  It looks like a set of 3 file folders on top of one another with the 
tabs at the bottom. This enters the code “&[Tab]” into the edit box. This causes 
the name of the spreadsheet sheet to appear in the right section of the header of 
the output. 

50. Click the “OK” button on the Header dialog box. 
Footer 

51. On the “Header/Footer” tab, select “Custom Footer…”. 
52. In the “Footer” dialog box, click in the “Left section:” edit box.  
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53. Click on the “Date” icon.  It looks like a set of 2 pages from a calendar. This 
enters the code “&[Date]” into the edit box. This causes the current date of the 
spreadsheet sheet to appear in the footer of the output.  

54. Click on the “Time” icon.  This causes the current time of the spreadsheet to 
appear in the footer of the output. 

55. In the “Footer” dialog box, click in the “Center section:” edit box.  

56. Click on the “Page Number” icon.  It looks like a sheet with the upper left 
corner bent and a pound sign # in the center. This enters the code “&[Page]” into 
the edit box. This causes the name of the spreadsheet sheet to appear centered in 
the footer of the output.  

57. Press the spacebar and enter the word “of”, and press the spacebar again.  

58. Click on the “Total Pages” icon.  It looks like a sheet with the upper left 
corner bent, and two plus-signs on the sheet. This enters the code “&[Pages]” into 
the edit box. This causes the total number of pages to appear centered in the footer 
of the output. 

59. Click the “OK” button in the “Footer” dialog box. Notice that the “Page Setup” 
dialog box displays a preview of the headers and footers. 

60. Click the “OK” button in the “Page Setup” dialog box. Notice that a dotted line 
appears on the spreadsheet. The area within these lines will print on one page. 

Print Preview 
61. View the planned output by pressing the “Print Preview” icon  on the Standard 

Toolbar. This icon looks like a blank sheet with the upper right corner bent, with a 
magnifying glass along the right edge. 

Print the Spreadsheet. 

62. Use the “Print” icon  on the Standard Toolbar. It looks like a printer with a 
sheet of paper coming out of the top. 

Print Formula Sheet 
Preparation: The “left single quote” key is the on the typing keyboard to the left of the 

“1” key. 
63. Select the formula sheet view using the following procedure. 
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a. Press “Ctrl + {left single quote}”. This acts as a toggle switch. It causes 
the display to switch back and forth between the normal spreadsheet view 
and the formula sheet view. Each time you press this key combination, the 
view swaps. 

 
Figure 1. Ctrl + Left Single Quote.1 

b. You should see formulas in column F. 
64. View and print the Formula View output. 

a. Use “Print Preview”. The formula sheet takes up more than one page. 
Notice that a button labeled “Next” appears at the left end at the top of the 
print preview screen.  

b. Press “Next” to see the second page. You should see the labels of column 
“A”, and the right-most column should be the column of formulas. 

c. Press the “Print” button at the top of the “print preview” screen. 
d. Click the “OK” button in the “Print” dialog box. 

65. Return to the normal spreadsheet view by again pressing “Ctrl + {left single 
quote}”. 

66. Save the Excel file. 
67. Exit Excel. 

                                                 
1 Illustration by Joshua B. L. Caldwell, 03 June 2003. 


